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1 Memobase

1.1 Recursos

Memobase é um pacote de software que oferece gerenciamento de dados de sensores para sistemas 

Memosens que permitem a completa documentação dos dados relevantes ao seu sensor e ao ponto 

de medição, por exemplo:

• Histórico de calibração

• Dados de uso do sensor como tempo de operação total, tempo de operação sob condições 

extremas de processo

• Atribuição a um ponto de medição ou a um grupo de pontos de medição

Memobase baseia-se na arquitetura cliente-servidor e permite o acesso de vários clientes. Todos os 

dados são armazenados em um banco de dados central.

O software pode ser combinado com os bancos de dados a seguir:

• SQLite

É possível instalar o banco de dados SQLite gratuito fornecido no CD Memobase e usá-lo em seu 

computador.

• Oracle1) em ODBC

Se já estiver usando um banco de dados Oracle, é possível continuar usando-o. Para isto, o driver 

ODBC apropriado para Oracle deve ser instalado em seu computador e um cliente de banco de 

dados apropriado deve ser configurado em seu computador. Caso tenha alguma dúvida, entre em 

contato com seu administrador de banco de dados .

Qualquer outro uso, que não o descrito aqui, não é permitido.

O fabricante não se responsabiliza por danos causados pelo uso indevido ou não indicado.

1.2 Requisitos de sistema

Os requisitos de sistema a seguir devem ser atendidos ao instalar e usar o Memobase.

• Sistema operacional: Windows XP1) SP2 ou Windows Vista1)

• Pelo menos 100 MB de espaço de armazenamento livre  no disco rígido

• Modem Commubox FXA291 

Informações sobre conexão e instalação do FXA291 são fornecidas no documento Informações 

técnicas (TI405C/07/en) e no CD de Instalação para FXA291.

• Adobe Reader1) 7.0 ou mais recente

Para exibir as Instruções de operação (também necessário se uma versão completa do Adobe 

Acrobat estiver instalada)

• Dispositivo para laboratório Liquiline 

1) Os produtos mencionados são marcas registradas de suas respectivas empresas.

Versão Parâmetro Versão de software 

CM42-M/N********* vidro pH, pH ISFET, ORP 10.05.00 ou mais

CM42-K********* Condutividade 13.05.00 ou mais

CM42-O********* Oxigênio 20.03.00 ou mais
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2 Identificação

2.1  Estrutura do produto 

2.2 Escopo de entrega

O escopo de entrega contém:

• CD de instalação com a configuração do Memobase e as Instruções de operação

• Número de série e chave da licença

• Resumo das instruções de operação

• Commubox FXA291 (opcional)

Software

1 Padrão

Versão

1 Padrão

Diagnóstico

A Padrão

Interface

1 não selecionado

2 FXA291

Idioma da documentação1)

D Alemão / Inglês

Opções adicionais

1 não selecionado

CYZ41D-

1) Esta opção refere-se apenas à seção Início. O software contém Instruções de operação completas em todos os idiomas 

de interface do usuário.
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3 Instalação

3.1 Assistente de instalação

Use o assistente de instalação para orientar a instalação do software Memobase. Ele também possui 

uma função de atualização. Portanto, se deseja atualizar seu software Memobase, inicie também o 

assistente de instalação.

1. Insira o CD em seu drive de CD/DVD.

O procedimento de instalação do Memobase inicia automaticamente. 

Se o início automático não estiver ativo, inicie o SetupMemobase.exe diretamente do CD.

2. Na caixa de diálogo exibida, selecione o idioma para a instalação.

Clique em OK.

3. O acordo de licença do software aparece.

– Leia o acordo de licença cuidadosamente.

– Selecione Concordo para aceitar o acordo e continuar a instalação do software.

– Clique em Cancelar se não desejar aceitar o acordo para interromper a instalação.

4. Na caixa de diálogo que surge, insira o número de série localizado atrás da caixa do CD.

Clique em Próximo.
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5. Insira a chave de licença. Ela também está localizada atrás na caixa do CD.

Clique em Próximo.

6. Especifique o diretório no qual o Memobase deverá ser instalado.

O Memobase é instalado no diretório a seguir, como padrão:

C:\Program files\Endress+Hauser\Memobase

Se desejar instalar o programa em outro diretório, clique em Procurar e selecione o diretório 

desejado.

Clique em Instalar para iniciar a instalação.

7. Na caixa de diálogo Database Installer, selecione seu tipo de banco de dados e especifique as 

informações de seu  banco de dados.

• Se estiver usando o Memobase com o banco de dados SQLite fornecido: 

– Selecione SQLite em Database type.

– Insira o diretório alvo no qual o banco de dados será instalado. 

O banco de dados SQLite é instalado no diretório a seguir, como padrão:

C:\Program files\Endress+Hauser\Memobase

Se desejar instalar o banco de dados em outro diretório, especifique o diretório desejado.
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• Se estiver usando o banco de dados Oracle em ODBC:

– Certifique-se de que o driver ODBC para Oracle apropriado esteja instalado em seu 

computador e que um cliente ODBC esteja configurado. Se necessário, entre em contato 

com seu administrador de banco de dados.

– Selecione ODBC em Database type.

– Insira seus dados de acesso para o banco de dados.

Clique em Instalar para continuar o procedimento de instalação.

8. As caixas de diálogo a seguir são exibidas, dependendo do tipo de banco de dados selecionado:

– Se estiver criando um novo banco de dados SQLite, a caixa de diálogo Create new 

database aparece.

Se já existir o banco de dados no diretório selecionado, uma mensagem aparece informando 

que este banco de dados será atualizado. Recomendamos fazer uma cópia de segurança do 

banco de dados antes de atualizá-lo.

Clique em OK.

O Memobase e os arquivos do banco de dados são copiados para o diretório alvo.

– Se estiver atualizando um banco de dados ODBC existente, a caixa de diálogo Update 

existing ODBC database aparece.

Recomendamos fazer uma cópia de segurança do banco de dados antes de atualizá-lo.

Clique em OK.

As definições e textos do Memosens são atualizados.

9. Na caixa de diálogo exibida, clique em Close para concluir o procedimento de instalação.
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4 Operação

4.1 Inicialização do programa

1. Certifique-se de que os drivers para o Commubox FXA291 estejam instalados em seu 

computador de acordo com as instruções de instalação.

2. Certifique-se de que o Commubox FXA291 esteja conectado ao Liquiline e à porta USB de seu 

computador.

3. Selecione Start > Programs > Memobase > Memobase.

4. A tela para login aparece:

Se estiver inicializando o Memobase pela primeira vez:

– Deixe Administrator como o nome do usuário.

– Não coloque nenhuma senha. 

A administração de usuário e as senhas são especificadas posteriormente no software.

Para todas as inicializações subsequentes:

– Insira seu nome de usuário.

– Insira sua senha.

Clique em Login.

5. A caixa de diálogo Modem selection  é exibida.

– Selecione a porta COM com a qual o Commubox FXA291 está conectado.

– Clique em OK.

6. A conexão com Liquiline está estabelecida.
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7. A interface de usuário Memobase é exibida.

4.2 Comunicação

4.2.1 Conexão do Commubox FXA291

Se Liquiline estiver conectado ao seu computador ao iniciar o Memobase, a conexão é estabelecida 

automaticamente ao iniciar o programa. 

Se Liquiline não estiver conectado ao seu computador, faça o seguinte:

1. Insira o plugue USB de seu Commubox FXA291 na entrada USB de seu computador.

2. Selecione Communication > Connect Commubox FXA291.

3. Na caixa de diálogo Modem selection , selecione USB Commubox FXA291 serial port. 

Clique em OK.

4. A conexão com Liquiline está estabelecida.
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4.2.2 Transferência automática do Liquiline (polling)

Por meio da função de transferência automática Liquiline, é possível salvar automaticamente toda 

calibração feita no Liquiline conectado no banco de dados Memobase.

A transferência automática Liquiline é habilitada como padrão. 

Portanto, se calibrar um sensor no Liquiline e confirmar a opção Store the data for adjustment 

(Armazenar dados para ajuste) , os dados de calibração são transmitidos para o sensor e para o 

banco de dados Memobase. Um novo registro de dados com os novos dados de calibração é criado 

automaticamente no banco de dados.

Para habilitar a transferência automática do Liquiline, faça o seguinte:

1. Selecione Communication e clique em Autom. Liquiline polling. Uma marca de seleção 

aparece ao lado de Autom. Liquiline polling e um ponto verde aparece na barra de tarefas. 

2. Para desativar a chamada seletiva automática, selecione Communication novamente e clique 

em Autom. Liquiline polling.

A marca de seleção ao lado de Autom. Liquiline polling desaparece e um ponto cinza 

aparece na barra de tarefas.

4.3 Personalização da interface do usuário

4.3.1 Seleção do idioma

O Memobase é fornecido com os seguintes idiomas:

• Alemão

• Holandês

• Inglês

• Espanhol

• Francês

• Italiano

• Japonês

• Polonês

• Português

• Russo

• Tcheco

O idioma da interface do usuário pode ser facilmente alterado se outro usuário desejar que a 

interface do usuário seja exibida em um idioma diferente.

Para mudar o idioma:

1. Selecione Options > Set language.

2. A caixa de diálogo Language selection é exibida.

– Selecione o idioma desejado para a interface do usuário, por exemplo Inglês

– Clique em OK.

3. O Memobase alterna para o idioma selecionado. Isto não afeta os dados armazenados.
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4.3.2 Visualização dos dados do sensor 

É possível configurar a visualização dos dados do sensor individualmente de tal forma que você 

tenha sempre as informações necessárias ao seu alcance.

Para personalizar a visualização:

1. Selecione Options > Preferences.

2. A caixa de diálogo Preferences é exibida.

– Em Preferences for sensor, selecione o tipo de sensor para o qual gostaria de personalizar 

a visualização.

Selecione CPSx1D para eletrodos de vidro, por exemplo, ou CLSxxD para sensores de 

condutividade.

– Selecione a guia para a visualização que deseja personalizar: Sensor view, Sensor user 

data, Database ou Statistics.

– Selecione os dados do sensor que devem ser exibidos.

! Nota! 

É possível restaurar as configurações padrões a qualquer momento. Para isto, clique em 

Defaults.

– Um vez que a visualização dos dados do sensor atenda suas especificações, clique em Close.

3. Os dados do sensor selecionado são exibidos e os dados desabilitados são ocultados.

! Nota! 

Ocultar os dados não afeta o banco de dados. Todos os dados são sempre salvos.

4.4 Administração do usuário

Para proteger o Memobase contra mudanças não intencionais ou indesejadas, é possível restringir o 

acesso ao banco de dados apenas aos usuários com uma senha e especificar funções a estes usuários. 

É possível definir as funções de usuário a seguir:

• Operador

Como operador, é possível salvar novos sensores Memosens ou editar os registros de dados 

armazenados e salvá-los como novos registros de dados com um novo registro de data e hora. No 

entanto, não é possível fazer modificações na especificação  de administração do usuário ou no 

ponto de medição (TAG).

• Especialista

Como especialista, você tem todos os direitos do operador. Além disso, é possível gerenciar a 

atribuição de ponto de medição. Não é possível fazer modificações na administração de usuário.

• Administrador

Como administrador, você tem todos os direitos de especialista. Além disso, é possível gerenciar 

os usuários.
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4.4.1 Criação, edição e exclusão de usuários

Proceda seguindo estas instruções para configurar a administração de usuário:

1. Selecione Options > User administration.

2. A caixa de diálogo User administration é exibida.

Para criar um novo usuário:

– Clique em Add user.

– Insira o nome de usuário desejado.

– Atribua a ele uma função de usuário .

– Insira a senha e repita a senha.

Para editar um usuário existente:

– Clique na entrada de usuário.

– Clique em Edit user.

– Altere a função de usuário ou a senha, conforme a necessidade.

Para desativar um usuário:

– Clique na entrada de usuário.

– Clique em Disable user.

3. Clique em Apply para salvar as configurações modificadas.

4.4.2 Conexão e desconexão dos usuários

Ao sair do banco de dados Memobase, é possível fazer a desconexão sem ter que fechar o programa. 

1. Para isto, selecione File > User logout.

2. A caixa de diálogo E+H Memobase - Login é exibida.

3. Um novo usuário precisa apenas inserir seu nome de usuário e senha na caixa de conexão para 

habilitar o uso do banco de dados Memobase.
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4.5 Atribuição de ponto de medição (TAG) 

O Memobase permite atribuir seus sensores a um ponto (tag)ou grupo de pontos de medição (grupo 

de tag).

Para não confundir os sensores ao substituí-los no campo, é possível, além da etiqueta externa com 

o Memoclip (Vide "Acessórios") - ativar uma verificação de sensor nos transmissores Liquiline. A 

atribuição correta do ponto de medição dos sensores é verificada. Uma atribuição incorreta dispara 

um alarme no Liquiline.

Os tipos de atribuição de ponto de medição a seguir estão disponíveis:

• TAG:

Se atribuir um TAG a um sensor, o sensor é totalmente vinculado a um ponto de medição. Ele 

somente pode ser usado neste ponto de medição e não pode ser usado em nenhum outro ponto 

de medição. 

Exemplo:

O sensor A está especificado ao ponto de medição TAG 1.

� O sensor A somente pode ser usado no ponto de medição TAG 1. Se ele estiver conectado a outro 

ponto de medição, um alarme é disparado.

• Grupo de TAG:

Se especificar um grupo de TAG ao sensor, o sensor pode ser usado em todos os pontos de 

medição pertencentes a este grupo de TAG. 

Exemplo:

O grupo TAG 1 é formado pelos pontos de medição X, Y e Z.

O sensor A está especificado ao grupo TAG 1. 

� O sensor A pode ser usado nos três pontos de medição X, Y e Z. Se ele estiver conectado a outro 

ponto de medição, um alarme é disparado.

4.5.1 Atribuição de ponto de medição (TAGs) no Memobase

Para atribuir os sensores gerenciados em seu banco de dados Memobase para um TAG ou grupo de 

TAG específico, é necessário criar uma lista TAG ou uma lista de grupo TAG.

Proceda seguindo estas instruções:

1. Selecione Options > TAG assignment.

2. A caixa de diálogo TAG assignment aparece.

Para criar uma nova entrada:

– Selecione a guia TAG list ou TAG group list.

– Clique em New.

– Insira o nome do TAG ou o grupo TAG.

Insira um comentário, se necessário.

– Repita as etapas anteriores para cada nome de TAG ou grupo TAG que deseje agregar à sua 

lista.

Para desativar uma entrada:

– Selecione a entrada que deseja excluir.

– Clique em Disable.



Memobase CYZ41D Operação

Endress+Hauser 15

3. Uma vez que a lista esteja concluída, clique em OK.

4. É possível agora atribuir um nome TAG ou um grupo TAG a cada sensor Memosens. Vide a 

seção "Leitura do Memosens" para este fim.

4.5.2 Configurações Liquiline - Atribua pontos de medição no 

Liquiline

Liquiline M CM42-K/M/N/O********* oferece as funções a seguir para administração do ponto 

de medição:

• Dispositivo para laboratório 

Com esta função é possível garantir que as informações de ponto de medição memorizadas no 

sensor não sejam sobrescritas ao calibrar o Liquiline.

Use esta função para os instrumentos usados no laboratório para a calibração central do sensor 

Memosens.

• Verificação do sensor (somente disponível com a "Versão avançada"):

Use esta função para especificar quais sensores são aceitos no instrumento Liquiline.

Ative esta função para os instrumentos que usa no processo e para os quais gostaria de atribuir 

sensores específicos.

! Nota! 

As duas funções são mutuamente exclusivas. No instrumento Liquiline, é possível habilitar o 

instrumento de laboratório ou a função de verificação do sensor.

 Instrumento para laboratório  

Uma vez que os sensores com a tecnologia Memosens memorizam os dados e a calibração, é 

possível calibrá-los de forma centralizada no laboratório. Para isto, use um Liquiline e ative a função 

de laboratório. Desta forma, é possível garantir que as informações de ponto de medição 

memorizadas no sensor (TAG ou Grupo TAG) não sejam sobrescritas. Isto significa que é possível 

usar novamente o sensor calibrado e seu ponto de medição especificado mesmo se a verificação de 

sensor estiver habilitada.

Para ativar a função de laboratório no Liquiline:

1. Selecione Setup > General settings > Lab device.

2. Selecione On e pressione o navegador para confirmar as entradas.

Verificação de sensor

Se atribuiu seu ponto de medição a determinados sensores de seu processo, é possível usar a 

verificação de sensor para garantir que apenas os sensores especificados ou sensores instalados de 

fábrica com precisamente o mesmo código possam ser conectados a este ponto de medição. 

Se outro sensor for conectado a este ponto de medição, o Liquiline rejeita este sensor e um alarme 

é exibido. 

Para ativar a verificação de sensor no Liquiline:

1. Selecione Setup > General settings > Sensor check. Selecione o navegador para confirmar.

2. Dependendo do gerenciamento de seu ponto de medição usando grupos de TAG ou TAGs, 

selecione TAG group ou TAG. Selecione o navegador para confirmar.

3. Dependendo da configuração feita anteriormente, selecione TAG number ou TAG group. 

Selecione o navegador para confirmar.

4. Insira o TAG number ou TAG group desejado. Usando o navegador, role até OK e confirme 

pressionando o navegador.
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4.6 Administração W@M 

O Memobase oferece acesso direto ao portal Endress+Hauser W@M. Neste portal, é possível 

encontrar informações adicionais e documentos referentes aos seus sensores.

Para criar o acesso W@M:

1. Selecione Options > WAM administration.

2. A caixa de diálogo W@M account settings  é exibida.

– Em Login, insira seu nome de usuário W@M.

– Em Password, insira sua senha W@M.

– Clique em OK.

Agora você tem acesso direto às informações W@M.

3. Selecione o sensor desejado na visualização do banco de dados.

4. Selecione File > WAM.

O portal W@M exibe automaticamente os registros de dados do sensor selecionado.

! Nota! 

Para acessar as informações W@M, seu computador precisa acessar a Internet.
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4.7 Visualização do sensor

A visualização do sensor exibe o sensor que está conectado ao seu instrumento de laboratório 

Liquiline no momento.

Na visualização do sensor é possível 

• Ler os dados do sensor

• Adicionar suas informações específicas para o sensor

• Salvar os registros de dados do sensor em seu banco de dados

• Atribuir o sensor a um TAG ou grupo de TAG específico, se necessário.

4.7.1 Leitura do Memosens

Proceda seguindo estas instruções:

1. Certifique-se de que o sensor esteja conectado ao seu transmissor.

2. Selecione Sensor view tab.

3. Clique em Read Memosens.

4. Os dados do sensor são lidos.

Se o banco de dados já contiver os registros de dados do sensor conectado, estes registros 

também são exibidos.

! Nota! 

• Os dados lidos não são salvos automaticamente. Para salvar os dados, vide seção "Armazenamento 

de dados" .

• Após trocar o sensor, clique em Read Memosens para atualizar os dados exibidos.
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4.7.2 Adicionar informações ao sensor 

1. Se desejar atribuir informações específicas ao sensor, clique em Open sensor information.

2. As informações do sensor são exibidas.

– Se deseja atribuir o sensor a um TAG ou grupo de TAG, clique na seta para baixo ao lado do 

campo TAG ou TAG group.

A lista de TAG ou a lista de Grupo de TAG criada anteriormente é exibida.

Clique duas vezes na entrada que deseja atribuir ao sensor. O TAG ou Grupo de TAG 

atribuído é armazenado no banco de dados, assim como o sensor.

! Nota! 

Os sensores que são operados no ponto de medição com um TAG que ainda não foi incluído 

na lista de TAG do banco de dados automaticamente criam uma nova entrada na lista ao 

serem memorizados. Um comentário neste ponto de medição pode sempre ser adicionado à 

atribuição do ponto de medição a qualquer momento.

– É possível desabilitar um sensor se não desejar mais usá-lo. Desta forma, é possível ver que 

ele não está mais integrado ao processo.

Clique na caixa ao lado de Active. A marca de seleção é excluída e a entrada muda para No. 

O sensor é indicado como não ativado no banco de dados

– Para inserir um nome Memoclip, clique no campo vazio ao lado de Label Memoclip. Insira 

as informações desejadas. 

– Para inserir um comentário, clique no campo vazio ao lado de User comment. Insira as 

informações desejadas. 

4.7.3 Armazenamento de dados

1. Clique em Store data.

2. O registro de dados é memorizado com a data e a hora lidas e armazenado no banco de dados.

! Nota! 

Um registro de dados não pode ser sobrescrito depois de armazenado. Isto protege o banco de dados 

contra manipulação.

Se fizer alterações em um registro de dados, por exemplo, mudanças nas informações do sensor, 

uma cópia é criada com um novo registro de hora.
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4.8 Visualização do banco de dados

Todos os sensores armazenados em seu banco de dados  são exibidos na visualização do banco de 

dados.

Para abrir a visualização do banco de dados, selecione a guia desejada.

Os dados são classificados seguindo estas instruções:

• O registro de dados mais recente está sempre à esquerda.

• Os dados no sensor selecionado no momento são exibidos na seção cinza superior.
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4.8.1 Informações exibidas

A visualização do banco de dados exibe as informações a seguir para os sensores, como padrão: 

vidro pH ORP pH ISFET Oxigênio Condutividade

Hora do evento Hora do evento Hora do evento Hora do evento Hora do evento

Identificação

Código

Número de série

Data de fabricação

Data de comissionamento

Etiqueta Memoclip

Ativo

TAG

Grupo de TAG

Identificação

Código

Número de série

Data de fabricação

Data de comissionamento

Etiqueta Memoclip

Ativo

TAG

Grupo de TAG

Identificação

Código

Número de série

Data de fabricação

Data de comissionamento

Etiqueta Memoclip

Ativo

TAG

Grupo de TAG

Identificação

Código

Número de série

Data de fabricação

Data de comissionamento

Etiqueta Memoclip

Ativo

TAG

Grupo de TAG

Identificação

Código

Número de série

Data de fabricação

Data de comissionamento

Etiqueta Memoclip

Ativo

TAG

Grupo de TAG

Informações ao sensor

Tipo de calibração

Ponto zero [pH]

Slope [mV/pH]

Data de calibração do pH

Buffer 1 [pH]

Buffer 2 [pH]

Número de calibrações

Delta ponto zero [pH]

Slope Delta [mV/pH]

Slope anterior [mV/pH]

Ponto zero anterior [mV/pH]

Transmissor de calibração S/N

Informações ao sensor

Tipo de calibração

Offset ORP

Data de calibração

Buffer ORP

Número de calibrações

Offset Delta

Transmissor de calibração 

S/N

Informações ao sensor

Tipo de calibração

Ponto de operação [mV]

Slope [mV/pH]

Isoterma [pH]

Data de calibração do pH

Buffer 1 [pH]

Buffer 2 [pH]

Número de calibrações

Ponto de operação Delta [mV]

Slope Delta [mV/pH]

Slope anterior [mV/pH]

Ponto de operação anterior 

[mV/pH]

Transmissor de calibração S/N

Informações ao sensor

Slope [pA/hPa]

Slope mín.

Slope máx.

Data de calibração de slope

Tipo de calibração

Data de calibração do ponto 

zero

Número de calibrações do 

sensor

Número de calibrações 

membrana

Slope Delta [pA/hPa]

Delta ponto zero [nA]

Slope anterior [pA/hPa]

Ponto zero anterior [nA]

Transmissor de calibração S/N

Informações ao sensor

Tipo de calibração

Const. célula [1/cm]

Delta Const. célula [1/cm]

Referência da temp.

Referência condutividade

Data de calibração da const. 

célula

Número de calibrações

Transmissor de calibração S/N

Calibração da temperatura

Offset de temperatura [K]

Data de calibração da temp.

Calibração da temperatura

Offset de temperatura [K]

Data de calibração da temp.

Calibração da temperatura

Offset de temperatura [K]

Data de calibração da temp.

Calibração da temperatura

Offset de temperatura [K]

Data de calibração da temp.

Calibração da temperatura

Offset de temperatura [K]

Slope de temperatura

Tipo de calibração de temp.

Referência de temperatura 1

Referência de temperatura 2

Data de calibração da temp.

Transmissor de calibração S/N

Tempo de operação

Horas de operação

Número de esterilizações

Temp. operação máx. [°C]

Uso > 80 °C [h]

Uso > 100 °C [h]

Uso < -300 mV

Uso < 300 mV

Tempo de operação

Horas de operação

Número de esterilizações

Temp. operação máx. [°C]

Uso > 80 °C [h]

Uso > 100 °C [h]

Tempo de operação

Horas de operação

Número de esterilizações

Temp. operação máx. [°C]

Uso > 80 °C

Uso > 100 °C

Uso < -300 mV

Uso < 300 mV

Tempo de operação

Horas de operação

Número de esterilizações do 

sensor

Número de esterilizações da 

tampa

Temp. operação máx. [°C]

Temp. operação mín. [°C]

Uso > 40 °C [h]

Uso > 80 °C [h]

Uso > 10 nA [h]

Uso > 40 nA [h]

Carga [μAs]

Corrente de fuga [nA]

Voltagem de referência [mV]

Voltagem de polarização [mV]

Tempo de operação

Horas de operação

Número de esterilizações

Temp. operação máx. [°C]

Temp. operação mín. [°C]

Condutividade máx.

Condutividade mín.

Uso > 80 °C [h]

Uso > 120 °C [h]

Uso > 140 °C [h]

Uso > 80 °C < 100 nS [h]

Contagem CIP

Informações personalizadas 

do sensor

Nome de usuário

Função de usuário

Comentário do usuário

Informações personalizadas 

do sensor

Nome de usuário

Função de usuário

Comentário do usuário

Sensor personalizado 

informações

Nome de usuário

Função de usuário

Comentário do usuário

Informações personalizadas 

do sensor

Nome de usuário

Função de usuário

Comentário do usuário

Informações personalizadas 

do sensor

Nome de usuário

Função de usuário

Comentário do usuário
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4.8.2 Operações na visualização do banco de dados

Na visualização do banco de dados é possível

• Filtrar e classificar as entradas do banco de dados

• Editar as informações do sensor

• Abrir as estatísticas gráficas.

Filtragem e classificação

1. Para filtrar e classificar seus dados, clique em Search.

2. A caixa de diálogo Search é exibida.

– Em Global filter, é possível decidir se deseja considerar todos os sensores ou apenas os 

sensores ativos ao executar uma pesquisa.

– Em Event time filter, é possível especificar o período para o qual a pesquisa deve ser feita.

– Em Detail filter, especifique as propriedades do sensor nas quais as entradas do banco de 

dados devem ser filtradas. No campo superior, selecione a propriedade do sensor, por 

exemplo, número de série ou TAG e insira os dados apropriados no campo abaixo, por 

exemplo, 7C024505E00 ou Tag 1.

É possível filtrar pelas entradas a seguir:

– Código

– Número de série

– Data de fabricação

– Data de comissionamento

– Data de calibração

– TAG

– Grupo de TAG

– Transmissor de calibração S/N

– Etiqueta Memoclip

– Nome de usuário

– Comentário do usuário

Clique em Search para filtrar e classificar.

3. Para exibir todas as entradas do sensor armazenadas, desative os filtros na caixa de diálogo 

Search e clique em Search.



Operação Memobase CYZ41D

22 Endress+Hauser

Abrir as informações do sensor 

1. Se desejar editar informações específicas do sensor, clique em Open sensor information.

2. As informações do sensor são exibidas.

– Se deseja remover um sensor do processo - devido a desgaste ou dano, por exemplo, é 

possível desabilitar esse sensor. É possível desabilitar os sensores que foram destruídos no 

campo.

Para isto, clique na caixa ao lado de Active. A marca de seleção é excluída e a entrada muda 

para No.

– Para inserir um nome Memoclip, clique no campo vazio ao lado de Label Memoclip.

Insira as informações desejadas. 

– Para inserir um comentário, clique no campo vazio ao lado de User comment.

Insira as informações desejadas.

Clique em Store data.

Os dados editados são salvos como uma nova entrada no banco de dados com um registro de 

data e hora atual.

Abrir as estatísticas 

As estatísticas do sensor fornecem uma alternativa gráfica de exibir os dados de calibração do sensor. 

Aqui, é possível visualizar imediatamente como o ponto zero e o slopeSlope do sensor mudam e usar 

esta informação para especificar os intervalos nos quais o sensor foi calibrado.

1. Clique em Abrir estatísticas.

2. As estatísticas do sensor são exibidas.

3. Se desejar fechar a visualização gráfica, clique em Close statistics.
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4.9 Exportação de dados

O Memobase oferece a opção de exportar entradas individuais do banco de dados ou todas as 

entradas dele para um sensor específico ou todo o banco de dados para vários formatos comuns, por 

exemplo, Excel, HTML etc.. Desta forma, é possível integrar os dados do sensor facilmente com 

outros sistemas.

4.9.1 Exportação de dados do sensor

Com a opção de Exportar dados do sensor, é possível exportar os dados do sensor que acaba de ser 

lido para um arquivo HTML.

Para iniciar a exportação de dados do sensor.

1. Clique em Sensor view tab.

2. Selecione as entradas de banco de dados que deseja exportar.

– Para selecionar múltiplas entradas, mantenha pressionada a tecla shift e clique na primeira e 

na última entrada na linha.

– Para selecionar múltiplas entradas aleatórias, mantenha pressionada a tecla Ctrl e clique nas 

entradas desejadas.

3. Selecione File > Sensor data export.

4. A caixa de diálogo Sensor data export é exibida.

– Selecione o diretório alvo.

– Insira um nome de arquivo.

– Clique em Save.

5. As entradas do banco de dados são salvas como um arquivo HTML no diretório selecionado. 

4.9.2 Relatório do sensor

O relatório do sensor exporta todas as entradas do banco de dados de um determinado sensor para 

um arquivo XLS.

Para criar o relatório do sensor:

1. Selecione File > Sensor report.

2. Na caixa de diálogo que aparece, insira o número de série do sensor para o qual deseja criar o 

relatório.

3. A caixa de diálogo Create a sensor report aparece.

– O Memobase cria automaticamente uma pasta com o número de série selecionado no 

diretório C:\Programs\Endress+Hauser\Memobase\Reports.

– Insira um nome de arquivo.

– Clique em Save para salvar o relatório na pasta criada.
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4. O relatório do sensor é salvo como um arquivo XLS.

Ele fornece as informações a seguir:

– Dados do sensor atual

– Todos os dados do sensor
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– Uma representação gráfica do histórico de slope

– Uma representação gráfica do histórico de ponto zero

4.9.3 Exportar banco de dados

Com a opção de exportação do banco de dados, é possível exportar as entradas selecionadas de seu 

banco de dados Memobase para um arquivo CSV.

Para iniciar a exportação do banco de dados:

1. Clique em Database tab.

2. Selecione as entradas de banco de dados que deseja exportar.

– Para selecionar múltiplas entradas, mantenha pressionada a tecla shift e clique na primeira e 

na última entrada na linha.

– Para selecionar múltiplas entradas aleatórias, mantenha pressionada a tecla Ctrl e clique nas 

entradas desejadas.

3. Selecione File > Database export.

4. A caixa de diálogo Database export é exibida.

– Selecione o diretório alvo.

– Insira um nome de arquivo.

– Clique em Save.

5. A entrada do banco de dados é salva como um arquivo CSV no diretório selecionado. 
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5 Acessórios

5.1 Comunicação

Commubox FXA291

• Módulo de interfaces entre interface CDI e USB-PC

• Informações técnicas TI405C/07/en

• Código 51516983

5.2 Transmissor

Liquiline M CM42

• Transmissor modular bifilar para áreas Ex  e não Ex

• Hart®, PROFIBUS ou FOUNDATION Fieldbus disponíveis

• Pedido de acordo com a estrutura do produto, Informações técnicas TI381C/07/en

5.3 Etiqueta externa 

Memoclip

• Identificação dos sensores Memosens

• 100 anéis plásticos incluindo folhas de etiquetas

• Código 71038228
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